
InType: Text Effects

In the April | May 2011 issue of InDesign Magazine, I wrote about type effects that relied 
on InDesign’s Pathfinder tools. I’d like to expand upon that by talking about type treat-
ments that use InDesign’s transparency effects.

Working with Gradients
Though simple enough, gradients can be 
tricky. Assuming you want to affect all the 
text in a text frame, select the frame with 
the Selection tool, then click the Formatting 
affects text button (either at the bottom of 
the Tool panel or the top of the Swatches 
panel). That way your text won’t appear as 
an inverse selection, and you’ll be able to 
better evaluate the result.

When creating a gradient, it helps to 
pull the Gradient panel out of the dock, so 

that you can have Gradient and Swatches 
open simultaneously. 

Start out by applying the standard black 
and white gradient to your selection: Click 
the gradient swatch in the upper left corner 
of the Gradient panel, or press the period 
(dot) on your keyboard to apply the default, 
or last-used gradient. To change the colors, 
click a color stop at the bottom of the gradi-
ent bar, then Option/Alt-click the color you 
want in the Swatches panel. You can add 
more colors to the gradient by clicking on 
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the bottom of the Gradient bar. To remove 
colors, drag them off the gradient bar.

To determine how gradually or swiftly 
one color transitions to another, drag the 
diamond slider on the top of the gradient 
bar (Figure 1). Their position indicates the 
point at which there is 50% of each color.

When you first apply the gradient, it 
ranges from the left side of the frame to 
the right; that is, if your text only fills the 
left half of the frame, you’ll only see the left 

half of the gradient in the letters. To have 
the gradient play out across the whole 
word or phrase, choose the Gradient tool in 
the Tool panel (or press G) and drag across 
your selection in the direction you want 
the gradient to go. If you drag beyond the 
bounds of the your selection, the gradient 
continues outside the letter shapes, and 
you’ll see it only within the letters.

Once you’ve made a gradient you like, 
drag its swatch from the Gradient panel to 
the Swatches panel to save it. Make sure 
you reapply the gradient to the text by 
clicking the swatch you just made. Though 
this won’t affect anything visually, it does 
ensure that the gradient on the text is 
tagged with the color swatch itself. That 

way, you can update the gradient through 
the Swatches panel (double click on the 
gradient swatch) and have it update wher-
ever it’s applied in the document (including 
the text).

Bevel and Emboss
Bevel and Emboss gives your text a raised, 
or even metallic look (Figure 2). It can look 
corny, but sometimes the added dimension 
really lifts a title treatment. What’s interest-
ing and different about this example—and 
what I hope will give you food for thought—
is that I’m using an Outer Bevel to make the 
type look like it’s being pushed out of the 
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In the XXX issue of InDesign Magazine I wrote about type effects that relied upon 
the use of the Pathfinder tools. Here I’d lke to expand upon that by talking about 
type treatments that rely upon transparency effects. 

Working with Gradients: Envy

Let’s start out with some tips for applyng a gradients, though simple enough, can 
be tricky. Assuming you want to affect the whole text frame, select the text with the 
Formatting affects text button, either at the bottom of the Tool panel or the top of 
the Swatches panel: that way your text won’t appear as an inverse selection, and 
you’ll be able to better evaluate the result.

When creating a gradient it helps to tear off the Gradient panel so that you can have 
Gradient and Swatches open simultaneously. 

Start out by applying the standard black and white gradient to your selection. To 
change the colors, click a color stop at the bottom of the gradient bar, then Alt-click 
the color you want in the Swatches panel. You can add more colors to the gradient 
by clicking on the bottom of the Gradient bar. To remove colors, just drag them off 
the gradient bar.

To determine how gradually or swiftly one color transitions to another, drag the 
diamond slider on the top of the gradient bar. Their position indicates the point at 
which there is 50% of each color.

When you first apply the gradient, it’s going to start and stop within every letter 
shape. To have the gradient play out across the whole word or phrase, choose your 
Gradient tool (g) in the Tool panel and drag across you selection in the direction you 
want the gradient to go. If you drag beyond the bounds of the your selection, the 
gradient will continue outside the letter shapes—you just see the portion of it that 
shows up within the letters.

Once you’ve made a gradient you like, drag its swatch from the Gradient panel to 
the Swatches panel. Make sure you reapply the gradient to the text, though this 
won’t affect anything visually. Doing so allows you to update the gradient through 
the Swatches panel (double click on the gradient swatch) and have it update 
wherever it’s applied in the document.

Bevel and Emboss: Wrath

For the second of my Seven Deadly Sins, I’m using a Bevel and Emboss Effect. As 
you’re probably know, Bevel and Emboss is useful if you want to give your text a 
raised metallic look. It can look corny, perhaps, but sometimes the added dimension 

Once the gradient is applied, drag 
over the text with the Gradient tool 
to determine its direction. In this 
example, to give the words more 
dimension, I’ve also added Inner 
Shadow, an Outer Glow and Satin 
Effects. Choosing Formatting affects text 

makes it easier to see what you’re 
doing when creating gradients; 
tearing off the Gradient panel 
allows you to more easily choose 
colors from the Swatches panel

Note that the effect is applied to 
the Text, not the Object. The color 
of the text is set to Paper and its 
Blend Mode to Multiply, which 
neutralizes white, so that all we see 
are the effects.

Figure 1: Once the gradient is applied, drag over the text 
with the Gradient tool to determine its direction. In this 
example, to give the words more dimension, I’ve also 
added Inner Shadow, an Outer Glow and Satin Effects. 
Choosing Formatting affects text makes it easier to see 
what you’re doing when creating gradients; tearing off the 
Gradient panel allows you to more easily choose colors 
from the Swatches panel.

Figure 2: Note that the effect is applied to the Text, not the 
Object. The color of the text is set to Paper and its Blend 
Mode to Multiply, which neutralizes white, so that all we 
see are the effects.
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In the XXX issue of InDesign Magazine I wrote about type effects that relied upon 
the use of the Pathfinder tools. Here I’d lke to expand upon that by talking about 
type treatments that rely upon transparency effects. 

Working with Gradients: Envy

Let’s start out with some tips for applyng a gradients, though simple enough, can 
be tricky. Assuming you want to affect the whole text frame, select the text with the 
Formatting affects text button, either at the bottom of the Tool panel or the top of 
the Swatches panel: that way your text won’t appear as an inverse selection, and 
you’ll be able to better evaluate the result.

When creating a gradient it helps to tear off the Gradient panel so that you can have 
Gradient and Swatches open simultaneously. 

Start out by applying the standard black and white gradient to your selection. To 
change the colors, click a color stop at the bottom of the gradient bar, then Alt-click 
the color you want in the Swatches panel. You can add more colors to the gradient 
by clicking on the bottom of the Gradient bar. To remove colors, just drag them off 
the gradient bar.

To determine how gradually or swiftly one color transitions to another, drag the 
diamond slider on the top of the gradient bar. Their position indicates the point at 
which there is 50% of each color.

When you first apply the gradient, it’s going to start and stop within every letter 
shape. To have the gradient play out across the whole word or phrase, choose your 
Gradient tool (g) in the Tool panel and drag across you selection in the direction you 
want the gradient to go. If you drag beyond the bounds of the your selection, the 
gradient will continue outside the letter shapes—you just see the portion of it that 
shows up within the letters.

Once you’ve made a gradient you like, drag its swatch from the Gradient panel to 
the Swatches panel. Make sure you reapply the gradient to the text, though this 
won’t affect anything visually. Doing so allows you to update the gradient through 
the Swatches panel (double click on the gradient swatch) and have it update 
wherever it’s applied in the document.

Bevel and Emboss: Wrath

For the second of my Seven Deadly Sins, I’m using a Bevel and Emboss Effect. As 
you’re probably know, Bevel and Emboss is useful if you want to give your text a 
raised metallic look. It can look corny, perhaps, but sometimes the added dimension 

Once the gradient is applied, drag 
over the text with the Gradient tool 
to determine its direction. In this 
example, to give the words more 
dimension, I’ve also added Inner 
Shadow, an Outer Glow and Satin 
Effects. Choosing Formatting affects text 

makes it easier to see what you’re 
doing when creating gradients; 
tearing off the Gradient panel 
allows you to more easily choose 
colors from the Swatches panel

Note that the effect is applied to 
the Text, not the Object. The color 
of the text is set to Paper and its 
Blend Mode to Multiply, which 
neutralizes white, so that all we see 
are the effects.
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background (Figure 3). Also, the fill color 
of the text is white and its blend mode 
Multiply, effectively making the text fill dis-
appear—all we’re actually seeing are the 
effects themselves. For some texture, I’ve 
added an inner shadow with 10% noise. 

Type on a Path Options
This effect is a variation of the text on a cir-
cle theme. Rather than your everyday cir-
cular text, I’ve used the often-overlooked 
Type on a Path options, which you reach by double-clicking the Type on a Path tool. As 

well as Skew (which I’ve chosen in Figure 4), 
there are also Rainbow (that’s the one you 

normally see), 3-D Ribbon, Stair Step, 
and Gravity options. Why doesn’t 
Illustrator have these? While the results 
can be a bit unpredictable, they’re 
worth checking out. 

In this specific example, the key is 
to use two separate circles. Putting 
text around a circle is always tricky, so 
if you’re doing anything that requires 

overlapping circles, use the Layers panel to 
lock one part of the composition while you 
work on the other. That way, you can select 
what you need to work on and avoid dis-
turbing those parts you’re happy with. 

Knock Out, Embossed Stroke, 
and Overlapping Frames
If you’ve ever wanted blurry text, maybe 
you thought you needed to do the fol-
lowing in Photoshop: First rasterize the 
text, then apply a filter like Gaussian Blur. 

Figure 4: InDesign’s Type on a Path 
effects are the type options that 
time forgot.

GREED
LUST

can really lift a title treatment. What’s interesting and different about this example—
and what I hope will give you food for thought—is that I’m using an Outer Bevel 
to make the type look like it’s being pushed out of the background. Also, the fill 
color of the text is white and its blend mode Multiply, effectively making the text fill 
disappear. All we’re actually seeing are the effects themselves. For some texture, I’ve 
added an inner shadow with 10% noise. 

Type on a Path Options: Greed and Lust

In this next example we see a variation of the text on a circle theme. Rather than just 
your everyday circular text, I’ve used the often overlooked Type on a Path options, 
which we get by doubleclicking the Type on a Path tool. As well as Skew, which 
I’ve chosen, we also have options called Rainbow (normal) 3-D Ribbon, Stair Step, 
and Gravity. How come Illustrator doesn’t have these? While the results can be a 
bit unpredictable, they’re definitely worth checking out. In this specific example, 
the key is, of course, to use two separate circles. Whatever effect you’re going 
for, putting text around a circle is always tricky, so if you’re doing anything that 
requires overlapping circles, consider using your Layers panel to lock one part of the 
composition while you work on the other. That way, you can select what you need 
to work on and avoid disturbing those parts you’re happy with.  

The type options that time forgot: 
InDesign’s Type on a Path effects.

Figure 3: Settings like the ones below will give you the 
look you see in the “WRATH” example.

T
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However, it’s possible to create this effect in 
InDesign and retain the text as completely 
editable (Figure 5). 

Like the effect on “wrath”, this one relies 
on seeing just the effect, without the fill 
color of the type. First, give the text a drop 
shadow. Then, if you’re working with a 
white background, set the text fill to Paper 

and its blend mode to Multiply—that will 
make it invisible. (To preview accurately, 
make sure to choose View > Overprint 
Preview.) Finally, disable the Object Knocks 
out Drop Shadow option in the Effects 
dialog box. All you see is the shadow, which 
you can adjust to your liking with its 
Color, Size, and Offset options.

What’s notable about the “Pride” 
example (Figure 6) is its embossed 
stroke. The Effects panel lets you 
apply transparency effects to the 
Object as a whole, or indepen-
dently to the Stroke, the Fill, or the 
Text. Unfortunately, if you’ve ever 

tried to apply a Bevel and 
Emboss effect to the Stroke 
of selected text, you’ll know 
this can’t be done… that is, 
unless you convert the text to 
outlines first (Type > Create 
Outlines, or press Cmd/
Ctrl+Shift+O). Although this 
renders the text uneditable, 

T
Figure 6: Converting the type to outlines, gives us the 
option of applying effects to the fill  and the stroke 
independently. In this example, I have embossed the stroke.

Figure 5: Uncheck Object Knocks Out Shadow, and you’ll  
see only the shadow—so long as the type is filled with 
white and its blend mode is Multiply.

More Effects: Sloth, Pride, ang Gluttony

If you’ve ever wanted blurry text, maybe you thought you needed 
to do this in Photoshop: first rasterizing the text, then applying a 
filter like Gaussian Blur. It’s actually possible to create this effect 
in InDesign and retain the text as completely editable. Just like 
the earlier effect (wrath) this one relies upon seeing just the 
effect, without the fill colour of the type. The problem is that 
because, unlike in Photoshop, there aren’t independent sliders 
for Opacity and Fill Opacity, if you reduce the opacity, the text 
disappears. Here’s the work around: if you ‘re working with a white 
background, setting the text fill to Paper and its blend mode to 
Multiply will make it invisible (to preview accurately, make sure to 
choose View>Overprint Preview). The other part of the equation, 
is to make sure Object Knocks out Drop Shadow is unchecked. All 
we see is the shadow, which you can adjust to your liking with its 
Color, Size and Offset options.

Notable about the Pride example is embossed stroke. The Effects 
panel allows us to apply transparency effects to the Object as a 
whole, or independently to the Stroke, the Fill, and the Text. But if 
you’ve ever tried to apply a Bevel and Emboss effect to the Stroke 
of selected text, you’ll know this can’t be done. Unless that is you 
convert the text to outlines (Cmd/Ctrl+Shift+O). It’s handy to know 
this because being able to apply effects to the Strokes of Objects 
opens up a whole new range of options.

For the last of our sins, I’ve used a bloated Bevel and Emboss, 
combined with the transparency effect of floating one piece of 
text on top of another and setting the blend mode of the top text 
to Multiply. It’s a simple and effective technique and it brings up a 
couple of good points: To do this, you’ll need to break the text into 
two distinct objects. Blend modes have no effect on overlapping 
text in the same text frame. Secondly, in the case of the Multiply 
blend mode, the result  where the the overlaps occur will be 
darker, so start out with a light shade of color, so that you have 

“growing room.”—there’s no point using dark colors, although 
other blend modes, like Screen or Color Dodge, might work in 
some situations.

Sloth

tonyglut 

Uncheck Object Knocks Out Shadow, and all we see in the shadow—so 
long as the type is filled with white and its blend mode is Multiply

Converting the type to outlines, gives us the option of applying effects to 
the fill  and the stroke independently. In this example, I have embossed the 
stroke.

By breaking the text into two text frames, I can overlap one with the other 
and set the blend mode of the top frame to Mutliply to create interesting 
interaction between the letter shapes.
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converting to outlines opens up a whole 
new range of options.

For the seventh lively sin, I’ve used a 
bloated Bevel and Emboss, combined with 
the transparency effect of floating one 

piece of text on top of another and setting 
the blend mode of the top text to Multiply 
(Figure 7). To do this, you’ll need to break 
the text into two distinct objects. Blend 
modes have no effect on overlapping text 
in the same text frame. And in the case of 
the Multiply blend mode, the result where 
the overlaps occur will be darker, so start 
out with a light shade of color.

Bonus: Text Wrap Effects
Figure 8 shows three approaches to text 
wraps. When creating non-rectangular text 
wraps, it’s often easier to begin by choosing 
the first button in the Text Wrap panel (Wrap 

around bounding box). This way, 
you can adjust the four sides’ offsets 
independently, and then switch 
to the third button (Wrap around 
object shape), which inherits your 
offsets. Then you can use the Direct 
Selection tool (it still has uses, even 
in CS5!) to adjust the exact shape of 
the wrap. Pay particular attention to 

Figure 7: By breaking the text into two text frames, I can 
overlap one with the other and set the blend mode of 
the top frame to Multiply to create interesting interaction 
between the letter shapes.

T

tonyglut 
Figure 8: The examples 
above right and 
immediately left use hidden 
layers. To make the text go 
inside the wrap object, as 
you see to the left, check 
the Invert button in the Text 
Wrap panel.

Text Wrap Tricks

Here we have three approaches to a text wrap. When 
creating non rectangular text wraps it may be easier 
to start out with Wrap around bounding box, adjust 
the four offsets independently, then switch to the 
third option, Wrap around object shape, which will 
inherit these offsets as its starting point. Then use the 
Direct Selection Tool (it still has uses!) to adjust the 
exact shape of the wrap: pay particular attention to the 
space above and below the object and make sure the 
leading of your text block remains consistent. 

The second and third examples make use of a hidden 

layer. Make sure that the Suppress Text Wrap When 
Layer is Hidden option isn’t checked. For the third 
example, the handy Invert option in the Text Wrap 
panel is checked, causing the words to go inside, rather 
than around, the text wrap object. For this to work well, 
you’ll need a shape big enough and simple enough 
that it doesn’t render the text completely unreadable 
(unless that’s what you’re after). You’ll probably also 
want to adjust the offsets. Here, I’ve made them a 
negative amount to push the text slightly beyond the 
bounds of the 7.
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You can hide the 
layer, but the text 
still wraps

Check the Invert 
button to make the 
text go inside the 
wrap object.

Text Wrap Tricks

Here we have three approaches to a text wrap. When 
creating non rectangular text wraps it may be easier 
to start out with Wrap around bounding box, adjust 
the four offsets independently, then switch to the 
third option, Wrap around object shape, which will 
inherit these offsets as its starting point. Then use the 
Direct Selection Tool (it still has uses!) to adjust the 
exact shape of the wrap: pay particular attention to the 
space above and below the object and make sure the 
leading of your text block remains consistent. 

The second and third examples make use of a hidden 

layer. Make sure that the Suppress Text Wrap When 
Layer is Hidden option isn’t checked. For the third 
example, the handy Invert option in the Text Wrap 
panel is checked, causing the words to go inside, rather 
than around, the text wrap object. For this to work well, 
you’ll need a shape big enough and simple enough 
that it doesn’t render the text completely unreadable 
(unless that’s what you’re after). You’ll probably also 
want to adjust the offsets. Here, I’ve made them a 
negative amount to push the text slightly beyond the 
bounds of the 7.
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the space above and below the object and 
make sure the leading of your text block 
remains consistent. 

The second and third examples use a 
hidden layer (Figure 9). Make sure that the 
Suppress Text Wrap When Layer Is Hidden 
option isn’t selected in the Layer Options 
dialog box (or else there’s no way you’ll get 
objects on that layer to cause text wrap). In 
InDesign CS5, you can also accomplish this 
by hiding the object itself (Object > Hide) 
instead of putting it on a hidden layer.

To create the third example, I enabled 
the Invert checkbox in the Text Wrap panel, 
causing the words to flow inside, rather 
than around, the text wrap object. For 
this to work well, you’ll need a shape big 
enough and simple enough that it doesn’t 
render the text completely unreadable 
(unless that’s what you’re after). You’ll prob-
ably also want to adjust the offsets. I speci-
fied a negative amount to allow the text to 
spread slightly beyond the strict bounds of 
the 7.

T Go Ahead and Sin a Little
There’s a place for sober, straightforward 
type. But for those times when your layouts 
call for something livelier, sin a little with 
one of these InDesign transparency effects.

Nigel French is a graphic designer, photographer, author, 
and teacher living in Brighton, UK. He is the author of 
InDesign Type and Photoshop Unmasked, both from Adobe 
Press, as well as several titles for the Lynda.com online 
training library.

Figure 9: In the Layer Options dialog, make sure to 
uncheck Suppress Text Wrap When Layer Is Hidden.

■
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http://www.amazon.com/InDesign-Type-Professional-Typography-Adobe/dp/0321685369/ref=sr_1_1?s=books&ie=UTF8&qid=1308158113&sr=1-1
http://www.amazon.com/Adobe-Photoshop-Unmasked-Science-Selections/dp/0321441206/ref=sr_1_1?s=books&ie=UTF8&qid=1308158158&sr=1-1
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Sticky Note
Follow us on Twitter!

http://twitter.com/#!/indesignmag
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